




Windows 10 guide SUPER GUIDE

Complete guide with tips and tricks to assist you
master, explore your windows 10 like a pro

GEORGE HARRIS
Copyright©2021

COPYRIGHT
No part of this publication may be reproduced, distributed, or
transmitted in any form or by any means, including photocopying,
recording, or other electronic or mechanical methods, or by any
information storage and retrieval system without the written
permission of the publisher, except in the case of very brief
quotations embodied in critical reviews and certain other non-
commercial uses permitted by copyright law.



TABLE OF CONTENTS
CHAPTER ONE

INTRODUCTION

CHAPTER TWO

SIGN IN TO YOUR COMPUTER

CHAPTER THREE

DESKTOP AND START MENU

CHAPTER FOUR

WINDOWS FILE EXPLORER

CHAPTER FIVE
MAKE ICONS LOOK LARGER IN FILE EXPLORER

CHAPTER SIX
HOW TO LOCATE YOUR FILES IN WINDOWS 10 PC

CHAPTER SEVEN
OPEN A NOTEPAD OR WORD DOCUMENT

CHAPTER EIGHT

USING OF CORTANA IN WINDOWS 10 PC

CHAPTER NINE

FIXING SMALL DESKTOP ICONS AND TEXT TOO SMALL

CHAPTER TEN

CONNECTING TO THE INTERNET

CHAPTER ELEVEN

SHUTTING DOWN THE PC

THE END



CHAPTER ONE
INTRODUCTION

This book is solely intended for users who have just began using
Windows 10 OS and will as well help the seniors who might also be
new to the PC. It is going to easily show you how to use Windows
10, beginning from how to sign-in, to how to shut your PC down. The
Windows 10 is with no doubt a bit special than the previous versions
of Windows, most in particular for the absolute beginners. When I
say the absolute beginners I simply mean the new PC users and the
grannies and grandpas who just began using the computer. In this
book, I am going to share some primary guidelines for using
Windows 10.

You have to be very sure always that your laptop battery is charged
very properly so that you do not run out of power at the wrong time.
If you are making use of desktop, you have to be very sure you have
extra battery backup as well.

CHAPTER TWO
SIGN IN TO YOUR COMPUTER

Each time you start your Windows 10 PC via clicking the Power
button, you will see a login screen; The PC will ask you to unlock the
display screen and then sign in. You simply have to click on your
name and type in your password (if you set it) to get in. If the laptop
is being used by different users, kindly check on the lower left corner
of your PC display screen and you will get the listing of users on the
PC.

On the right side of your screen, you will see some icons, simply
hover over them with your mouse cursor and you will clearly get an
insight of what they are there for.



Various methods to sign into your windows 10:

Microsoft incorporates more than one feature and abilities to
Windows 10 and has made it less difficult than ever to authenticate
yourself on a PC. You can make use of a Password, PIN, Picture
Password when logging into your computer. From your Windows
login screen, you can effortlessly switch between these sign-in or
log-in options.

Additionally to the common password-based login, Windows 10
equally consists of PIN and Picture Password login for the protection
and security of users. You can make use of Microsoft e-mail account
based login or a Local account to access your computer. However,
we do have some design conflicts that might also not allow you to
use either of the PIN or a Picture Password to log into your
computer. For example, when you are in a Safe Mode, neither of
these choices works out, and you must have a traditional password
in that case to get through.

This offers a rundown to the process of Windows 10 Sign in options.

Change of Password:
Kindly open the Start Menu and then click open Settings. Select
‘Accounts’, next, kindly select ‘Sign-in options to create a new
Password and click on the Change button below heading
‘Password’.





Next, enter the ‘Current password’ and click on Next.

In the new window that appears, just type in new password, then re-
enter the new password, enter a trace for the password hint and now
click on Next button.



Finally, click on ‘Finish’ for completing the change to the user
password. The next time you sign in, you will have to make use of
your new password.

Changing Picture Password on the Windows 10:

A Picture Password permits you make use of an image from your
library as a password. You must perform three gestures on the
photograph that you want to use as your password. For instance,
you can edit, draw and also resize some component of the image as
you want.



 In your Windows 10
Settings app, below the ‘Picture Password’ area as it is shown in the
screenshot below, click on Add.

Next step, key in your user password and then click OK to confirm
your account info.

Next, simply click on ‘Use this picture’ to continue.



Now, you have to draw three new gestures on the picture. Repeat
the step and then click ‘Finish’ to exit.

Changing PIN in the Windows 10:

If setting up a Picture Password is too hard for you, and you still
want to experience a change in your procedure of login, Microsoft
Windows has a way out for you in the form of PIN.



Here, just under your Settings > Accounts > Sign-in options, simply
select change button under the ‘Pin’ section.



Now, simply key in a password and then click OK.

Next, type in a new 6 digit PIN and then select Finish.

You can as well make users use a complex PIN for signing in just by
enabling the Pin Complexity Group Policy.

CHAPTER THREE
DESKTOP AND START MENU



Immediately you are signed in, you will now be at the Desktop, which
is the basic overview of your PC. You can open all the files in your
PC, folders and applications from here. You will now see some icons
and the Taskbar at the bottom of the screen that has more icons and
the Start button in the extreme left corner of the screen.

If you want to open any of your applications or programs on the PC,
you need to make use of the Start Menu . Just click on the Start
button  on the lower left corner of your PC screen, and it will show a
window with all your apps, games and programs installed on the PC.



Choose any app you want and open it. All the apps here are
alphabetically categorized, and thus makes it very easy to find an
app.

Play around it a bit to get the hang of it.

Customizing the Windows 10 Start Menu:

Start Menu  is back in the Windows 10 , and it does look great! Not
only that it is good to look at, it is now super charged and enables
you do a lot more as well. Let’s take a look at some of its features
and then see how to personalize the Windows 10 experience, by
customizing the Start Menu.



As it is expected, Start Menu, or simply Start , gives you the access
to your User Documents, the Oft-used and pinned software and
apps, File Explorer and many others. Something quite new here, is
that the Start now includes Live Tiles also.

You can:

1. Remove frequent items from the Start Menu.

2. You can disable content suggestions that Microsoft may show on

top of the start menu from time to time, it is mostly related to the

Windows store apps that Microsoft thinks you will be interested in.

3. You can also remove the New list by turning off the “Show recently

added apps group”. However, this will not prevent All Programs  from

showing New under the option, and immediately you expand All

Programs. New items will show New under the item name. The

option “Show Recently Added Apps Group” removes only the folder

or the group that contains a list of newly added apps. The group is

very useful when you cannot find your programs in All Programs,

 but when you have expanded it, you will then find it mighty long to

get confused among the list it produces.

4. From just the same window, you can also opt to Turn Off the list of

recently opened items, you should know that it is different from



recently added as the latter shows list of the recently installed

programs and the recently opened items shows list of all the

documents, spreadsheets, image files, sound or video files. In fact,

this option enables you to see the list of data files, while the option

that was mentioned in number 3 above, only shows the list of

recently added or installed programs.

5. Finally, you can now get the Start menu to be shown in full screen,

There won’t be any need for the regular users to show the Start

menu in full screen but for those who are making use of tablets and

mobile devices.

6. Show colour on the Start menu and also the Taskbar.

7. You can pin any system setting to the Start.

Start Menu and some of it’s settings in Detail:

Live Tiles and Group: The Start includes Tiles, You can pin the
Tiles to Start. If the app is programmed to show Live Tiles, you will
then see Live Tiles in your Start Menu as well. You can be able to pin
apps, program shortcuts, files, folders and also the Drive to Start.
You just have to simply right-click on the item and select Pin to Start.
Easily drag and drop them around to arrange them in Groups and to
give the Groups useful names.

The exact context menu for each Tile would include:

            Unpin from the Start



            Pin to  the taskbar

            And Uninstall

            Resize to Small, Medium, Wide, or Large

            Turn off Live Tile.

You can now move the tiles, resize them and as well group them.
You can also move items from the left side to right size of the Start
and display them as Tiles. You can equally uninstall apps from the
Start itself, making use of its context menu.

Givin it the Classic Windows 7 look: If you want, you can simply
right-click on each tile and unpin it at once, to make the Start look
very compact, giving it the classic look.

Resize the Start or make it to Display full Screen: You can easily
resize the Start Menu just by dragging at its right and top edge. You
can as well show the Start Menu in full screen through Settings >
Personalization > Start.

Most of the Used Programs: The Start shows the most used
programs. This gives you an easy access to the apps and software
that you use from time to time. But if you want, you can also remove
this Most Used list.

The recently added Apps and Softwares: If you have installed
new apps or software, they would definitely get listed here. You
can also show or hide your Recently added apps group.



The Content Suggestions: The Start will as well recommend apps
and content to you, which it thinks may be of interest to you.
However, you can simply disable this feature if you find it not
interesting, through Settings > Personalization > Start.

The Quick Navigation to Apps list:



Open the Start, tap on All apps. Next, simply click on any alphabet –
say A. You will then see the alphabets displayed. Click on any of
them and you will be moved to the apps starting with that alphabet.



Tweak Start The Menu Properties:

Kindly Right-click on the Windows 10 taskbar and then select
Properties. Under the Start Menu tab, you will now see a
Customized button. You have to Click on it to open the Customized
Start Menu box. Here you will be able to customize how the links,
icons and the menus look and also behave on the Start Menu. You
can as well add the system items and disable or enable the context
menus and the drag-and-drop function. This box provides you with a
lot of options to customize Start Menu in the Windows 10.

CHAPTER FOUR
WINDOWS FILE EXPLORER



You can either make use of the keyboard shortcut Ctrl+E to open the
File Explorer or you can click the icon in your taskbar.





Once the File Explorer is open, you can then double click on any
folder you want, to open it.

Windows 10 File Explorer Tips and Tricks:

The Windows OS comes with an inbuilt File Explorer which everyone
makes use of on daily basis. Though there are many Explorer
alternatives  that are available, the default files explorer remains the
most used mainly because it is very much straightforward and also
easy to use for anyone. That means, it equally remains the most
underused application on the Windows 10, and there are bunch of
things you can do with a File Explorer. Here, I am talking about some
of the best File Explorer Tips and Tricks for a management of your
files.

These tips will go a long way to help you get the best out of Windows
10 File Explorer:

1. Sharing files instantly with Windows 10 apps:
Now, Windows 10 comes with a native sharing which permits one to
share multiple or a single file with apps like Twitter, Facebook,
Messenger, Fresh paint, OneNote, Paint 3D and many more.

1. Simply select multiple files, right-click, and then click on Share.

2. This will now open up Share menu which shows the list of

frequently contacted people, and the list of apps which support it.

3. Now select the app or contact with which you wish to share, and it

will open up that app with all the files attached to it.

If you cannot find the app in the menu, you can choose to Goto the
Store option, and download the app. If only the app supports this



feature, it will be listed.

It is equally the best way to directly email plenty of files to anyone.
Interesting to be aware, that Windows 10 does not open the full
outlook, but will offer you inline way or everything under a small
window for a seamless experience though.



2. Finding More Apps for your Files:

There are many apps in the store which might offer to do more
things than the native app that comes preinstalled on Windows 10.
For example, if you do want something better than the notepad, all
you need to do is this:

1. Simply Right-Click on the file.

2. Now Go to Open With and then select “Search the Store”.



This will now search the Microsoft Store for apps which selects the
file type. You can decide now which apps to try based on their
description, and their rating.

3. Opening the PC by Default:

Do you remember the days when clicking on the files explorer icon
opened “My PC” revealing list of the hard drives, CD Rom, and
another connected device? That is not the default case anylonger,
now you get to see a “Quick Access” section which shows your
frequently used files, and a bunch of shortcuts.  While they are
useful, you can frequently access them by doing right-click on the
File Explorer icon on the taskbar.

Here is how to make File Explorer open to This PC instead of Quick
Access.

Open File Explorer, and then right-click on the “Quick Access” icon

on the left panel. And Select Options.





            This will open the “Folder Options” Window.

            In the General tab, locate a label which says “Open

File Explorer to”.

            Now Select “This PC” from the drop-down.

            And finally, Save and exit.



Now, this will make sure the Windows File Explorer will open “This
PC” which reveals all the hard-drive partitions, and folders.

4. Deleting Recent File History:

If you have got a PC which is used by different people, it is a very
good idea to clear off the recently or the frequently visited files for
good. Though it is always a good idea that you create a separate
user just for yourself, and a guest account for other people, but if that
is not the issue and your family members shave privilege to log into
your account, then you really need to be careful about it.



            Open up the Folder Option by following the steps

mentioned above.

            Kindly look for the “Privacy” section.

Here you have just two options.



                  Show the recently used files in Quick

Access

                  Reveal the frequently used folders in

Quick Access.

            Then Uncheck the both of them.

Now this will make sure that nothing gets listed and shown to
everybody. To clear all the recent file list till now, simply tap on the
clear button to clear the File Explorer History.

How to Rename Multiple Files with the Name of your Choice:

If you have been making use of Windows for a very long time, you
know already that when renaming multiple files, Windows takes
name of the first file you choose, then adds suffix with numbers in
brackets. As shown in the picture below.



Now, what if you wish to rename multiple files, but each name should
be different, and you don’t have to make use of the rename menu or
pressing F2 for every file? That is possible and here is how you can
do it.

            First, Select first file, and press F2 or right click >

Rename.

            Once you are sure with the name you choose,

press theTAB.



           You will then see that the next file is in “Rename

Mode” and here you can type in the name of your choice.

            Continue pressing TAB till you are through. In case

you wish to skip few files in between, simply press Tab to

skip.



6. Show the Recycle Bin in the Sidebar on Demand:

The Windows 10 hides a lot of folders including the Recycle Bin from
the Windows Explorer Navigation bar on the left. While you may
argue that clicking delete is much better than drag, and drop, but
many might choose drag, and drop files to be available. Aside this, it
as well helps to quickly access the recycle bin in case you want to
restore some of the deleted files later.

            Just Right-click anywhere on an empty place on the

Navigation bar panel.

            This will now open a list of options including “Show

All Folders”.

            When you select it, it will display Recycle Bin.

The only problem is that it also shows lots of folders which you might
not find interesting. So to hide them, simply retrace the option in a
similar way also.

7. Disabling Advertisement in the Windows Explorer:

Here, microsoft promotes its own apps to the Windows consumers,
along with the Start menu, and the Notification panel, the
advertisement shows in the File Explorer as well. Though the
intentions are nice, these are distracting whenever you are occupied
with work. Luckily, these ads in Explorer can be disabled for good.

            Simply open the Folder Options, and switch to View

Tab.



            Now Under the Advanced Settings, scroll down to

locate a checkbox which says “Show Sync Provider

Notifications”.

            Now Uncheck it, and click ok, and all the

advertisements will be off.





8. Do you miss Creating new File types? Here is how to do it:

In the previous versions of Windows, there is an option which lets
you to quickly create a file types, including image files, a notepad,
and many others. It normally comes super handy when I had to note
something quickly. But you might have a different use case, but you
have the idea. Windows 10 does not have this option, but you can
now add new file type in the New item of the context menu with a
registry modification easily.

Warning: This is only for those who knows registry. If you don’t know
it, please do not try it.

Kindly open a Notepad and paste the following:

                  Windows Registry Editor Version 5.00

                 

[HKEY_CLASSES_ROOT\.XXX\ShellNew]

“NullFile”=””

            Then Replace XXX with any file of your choice such

as .png, .docx, and so on.

 You can save file now as “ADD PNG.reg”. You will be requested to

confirm your action.

            Once it is done, just double-click on this reg file, it

will add the extension under the “new”.

Once you succeed in adding the needed file types, it should
resemble the image below.



So much has changed post-Windows 10 Anniversary Update, now
File Explorer has more features that integrate with the rest of the
operating system, now bringing it close to mobile like experience,
and it fits well with this generation of users anyway.

CHAPTER FIVE
MAKE ICONS LOOK LARGER IN FILE EXPLORER



You can take a view of the folder icons in listed form or in a grid form.
Also, the icons in grid form are always small in size by default.
However, you can view them easily as medium icons, large icons or
extra large icons.



You just need to click on the View tab in the menu ribbon above and
select the size you want.

How to Cut or Copy and Paste using Keyboard or Mouse in your
Windows 10:

Cut, Copy, and Paste are without doubt the most basic used
commands in Windows computers. It is such a simple operation, and
a regular PC user might find this information of little use, but now we
have many new PC users who are searching for how to cut, copy or
paste by using a mouse or a keyboard.Therefore, will cover very
basic Windows tutorials for beginners too.

The difference Between Cut and Copy:

First, there is a clear difference between Cutting and Copying
something. When you cut and paste an image or a text, you are
really removing it from one location and getting it into your clipboard,
meanwhile copying will create a duplicate image or a text. Once
something is copied on your clipboard or temporary memory, you
can now paste it in any document, file, or folder of your PC. You can
copy nearly anything from the Internet, but cutting a text or an image
from the web is not possible in any way. So basically, we use ‘CUT’
option whenever we want to move an image, text, a file, or a folder
from one location to another location, and then we use ‘Copy’
whenever we want to create a duplicate item.

What is a Clipboard: Before we go ahead, it is very important that
you understand what a Clipboard is. The Windows PCs come with a
feature called Windows Clipboard, which stores information
temporarily, thereby letting you to move or paste it in another
location. The data which is stored in the clipboard eventually gets
deleted when you restart or shut down your PC. Clipboard is simply



used to keep storage of the data you want to paste in some other
location of your PC.

CUT, COPY and PASTE using Mouse:

When you want to Cut or Copy a file or folder  on your PC, right-
click the button of your mouse and then select ‘Cut’  or ‘Copy ’. Now



go to the folder where you want to get the file or a folder, just click
the right button of your mouse and then select ‘Paste’.

In the same way, to Cut or Copy an image  from one folder to
another folder, just take your mouse cursor to the image, then click
the right button of your mouse, and select the desired option. If you
want to paste, simply go to the desired folder,and click the right
button of your mouse, and select ‘Paste’.

 If you want to cut, copy
and paste a text  via using the mouse, first you need to take your
mouse cursor to the text you want to copy. When you want to select
the text, just click on the left button of your mouse, hold it, and then
drag it over the text you want to select. The selected text will be
displayed in a different color.

Simply click on the right button of your mouse and then select ‘cut ‘
or ‘copy’ . If you want to paste the text, select ‘Paste’.   Paste
Options, when it is offered, gives you extra pasting options like
keeping/discarding formatting, and so on.

How to CUT, COPY and PASTE using the Keyboard Shortcut:

While it is very easy and direct to cut, copy, and paste by using a
mouse, using a keyboard shortcuts is easier and faster. Not all the
PC users may be aware of the keyboard shortcuts, but it is very



important to know about them so that you can work even when your
mouse stops functioning.

            The Keyboard shortcut to Select all- Ctrl+A

            The Keyboard shortcut for Cut- Ctrl+X

            Here, Keyboard shortcut for Copy is - Ctrl+C

            Here,Keyboard shortcut for Paste is - Ctrl+V.

Kindly select the file, folder or image, by using Ctrl+X or Ctrl+C. Now
open the folder where you wish to paste the item and then press
Ctrl+V. When you want to select all items in a folder, simply
press Ctrl+A  and use the cut, copy, paste keyboard shortcuts.

If you want to select a piece of text using the keyboard, first you
need to take the cursor to the text, then press Ctrl+Shift,  and Left
 or Right arrow  keys as needed. Continue pressing the arrow keys
to choose the words right or left. Use the Up and Down arrow  keys
to select paragraphs. If you wish to select a complete line, simply
take the cursor to the end of the line and then press Shift+Home  on
your keyboard.

Move or Copy by using Command Prompt:

Now, this is a method for advanced users and seniors. You can as
well use the Command Prompt to Move or Copy files. To do such,
simply note down the path of the file or folder to be cut or copied.
Also note down the actual path of the destination folder.

Now kindly click on the Start Button in Windows 10 and then select
Command Prompt.

The syntax to be used is this: For Copy:



copy [/d] [/v] [/n] [{/y|/-y}] [/z] [{/a|/b}] Source [{/a|/b}] [+ Source

[{/a|/b}] [+ ...]] [Destination [{/a|/b}]]

For Move:

move [{/y|/-y}] [Source] [target]

Now that you have known all about these simple tricks to cut, copy,
and paste the data from one location to another location, it will be
very easy for you to work on your Windows PC.

CHAPTER SIX
HOW TO LOCATE YOUR FILES IN WINDOWS 10

PC





One of the most common issues is that we frequently forget which
particular file is stored and in which folder. So here is a very simple
tip for that too, You really don’t need to browse the entire PC and the
documents to find a particular file. You just have to make sure you
remember the name of that file and type it in the search box in the
lower left corner. The system will now display the files with matching
names automatically, and you can then select and open the file you
want.

The Windows Troubleshooting Tips:

1. Run System Restore

The very first thing to do is to try to restore your Windows computer
to a very good point. To do such, open the Start Menu>
Accessories> System Tools> System Restore. Or you simply type in
rstrui.exe  in your start search and then hit Enter.



This will now open System Restore. Here, kindly select a prior good
point, where you know that you weren’t facing this problem and then
try to restore your computer to this point by just clicking on the Next



> Finish button. Immediately Windows completes the restoration
process and restarts, then check if your problem has gone away.

2. Running System File Checker

Another thing you can possibly do is to run the in-built System File
Checker utility. Surprisingly, this tool is not often used, although it
could make some of your problems go away without stress. This tool
is used to check if any of your system files have been replaced,
damaged or have been corrupted and replaces them with “good”
files.

If you want to run the System File Checker, simply type in cmd  in
the start search and in the result which pops up, then right-click and
select Run as Administrator. This will now open up the Command
Prompt with administrative privileges.



Now you have to type in sfc /scannow  and then hit Enter. This tool
will take some minutes to run.  Immediately it completes its course, it
will now present a report. If there be any damaged, corrupted or
missing system files, they will be listed out. Kindly restart your
computer. On restart, all your system files will be replaced with the
‘good’ ones.

3. Fixing Windows Image or Component Store Corruption

You can as well use DISM.exe to repair corrupt Windows Image or
fix Component Store Corruption

You can use Dism /Online /Cleanup-Image /RestoreHealth.This
checks for the component store corruption and records the
corruption and fixes the corruption by using Windows Update.

4. Removing Unwanted Programs

Simply open the Control Panel and check your installed programs.
Do you see something you don’t find interesting, or something you
didn’t install, and you suspect it could be a rogue or an unwanted
software? Uninstall it.

5. Scan for a Malware

You have to run a full in-depth scan of your system with your anti-
virus. If your security software permits you to schedule a boot-time
scan, that’s great, you can go ahead and schedule one,  a regular
scan should be okay too, no problems. If you want to save your scan
time, you can use the Disk Cleanup  utility or the CCleaner or rather
use the Quick Clean to easily remove your junk files. If you have a
malware that is preventing your Windows from functioning as it
should, then your anti-virus scan should be able to take care of it
anytime, by removing the malware.

6. Windows Computer refusing to Start:



If your Windows refuse to start, see if you can be able to boot into
Safe Mode. To do that, you must keep pressing F8 when your
computer is starting.

If you notice that your Windows computer just won’t start, you can
easily repair boot problems with the Windows Startup Repair. The
Startup Repair is a Windows recovery tool that can fix some certain
system problems that might prevent Windows from starting up. The
Startup Repair scans your computer for the issue and then tries to fix
it so your computer can start normally. The Startup Repair is one of
the recovery tools in the System Recovery Options menu. The
Windows 10 users can access Advanced Startup Options.

7. Running Windows Update:
In the case that Microsoft has released fixes for your problems, so it
will be a very good idea to run Windows Update and see if any are
available. If they are available, then you have to download and install
them.

8. What to do when Windows Desktop appears Blank on
Startup:

When you notice that your computer starts, but will stop at the logon
screen or your desktop does not appear or that you saw a black
screen or you only see your wallpaper, the reasons could be much,
but in many cases like this, it is just the explorer.exe that is not
starting automatically. Well, simply press the Ctrl-Alt-Del and start
the Task Manager.





Here, simply click on File > New Task (Run) > type “explorer.exe”
and then click OK. Hopefully this should start your explorer.exe and
bring up your desktop. This is a basic something you could try. Once
this is done, you can now explore other troubleshooting options.

9. Fixing The Window:

Is your Recycle Bin not refreshing properly? Or maybe things are not
just fine with your Windows Media Center and you need to flush &
rebuild Windows Media Center database, or maybe you noticed that
for some reason your right-click context menu has been disabled in
Internet Explorer,  Maybe you have opted to be not-warned while
deleting the Sticky Notes and you now want the warning dialog box
back on, or probably, you post a malware attack and you realized
that your task manager or cmd or your Registry Editor has been
disabled.

NOTES:

1] The Windows Software Repair Tool from Microsoft will repair
system components and detect the corrupt files, resync the System
date and Time, reset the System Settings, reinstall the System
Applications and run the DISM Tool to repair system image, just with
a click.

2] Like 50 problems and 1 solution. FixWin  is the Windows Doctor
that you definitely would like to have on your computer, just 1-click
fixes all that and many more, such common Windows problems are
offered in this well-acclaimed freeware.

10. How to Repair Windows:

If you realize that your Windows installation had being badly
corrupted and even running system restore, the system file checker,
or you have been trying other troubleshooting steps, but it does not



really help, and you start to think of re-installing your Windows
operating system, just try a Repair insall first. The Windows 8/10
users may consider using the Refresh or the Reset Windows or the
Automatic Repair feature.

CHAPTER SEVEN
OPEN A NOTEPAD OR WORD DOCUMENT

The Notepad and Word are the two most mainly used programs for
writing.There are lot of ways to open a Text Document or a Notepad
in Windows 10 PC, i am mentioning the simplest ways here.

Simply type Notepad  in the search bar in the lower left corner of
your PC screen, just next to the Start button, and you will see the
results there. Just Click on Notepad  to open it. You can easily open
any program this way.





For opening programs, you can as well open the Start Menu , and
scroll down to W , click on Windows Accessories  and then
select Notepad.  





If you frequently use Notepad in your PC, it is always best to pin it to
the Start Menu or the Task Bar for a quick and easy access. 

When you want to pin the Notepad in Start Menu or the Taskbar,
simply type in Notepad  in the search box, select it, right-click and



then select Pin to Start  or Pin to Task Bar , and it is done.

Once it is pinned, you can then open it directly from the Start Menu
 or the Taskbar.



CHAPTER EIGHT
USING OF CORTANA IN WINDOWS 10 PC



The Cortana is your virtual assistance in the Windows 10 PC. She
will actually help you in doing chores in your PC. You can just speak
to her, and she will help you out. To open the Cortana, simply press
Win+S. Now click on the microphone icon and start commanding.
You can as well type give your commands if you don’t want to speak
to it. Just give your commands and watch her doing wonders.

How to Enable and Setup Cortana in Windows 10:

To start with, simply click inside the taskbar search box. The Cortana
settings box will be displayed as shown below. Kindly move the
slider to On  position, to enable the Cortana, so it can give you some
suggestions, ideas, reminders, alerts and so on, on your device. You
can also move the slider to the On  position for Hey Cortana  here.
When you scroll down, you will see settings that allows you to turn
on or off, Flights information and Taskbar tidbits as well.





If at all you need to access these settings again, you just have to
click on the hamburger menu > Notebook > Settings.

Once you have enabled the Cortana, you will now see a privacy
statement as follows. Simply click on “I agree” to forge ahead.





Next, it will now ask you for your name. Kindly enter a name that you
would like Cortana to call you as, and then click Next.





You will now be asked for access to use your location to serve you
with a better result. Clicking on the Yes  and Allow  is recommended,
I would say.





Once it’s done, the Privacy settings app will now open up. Kindly
choose the apps you want to enable access to your location.

When you successfully do that, you may now exit the Privacy
settings app.

Now, you are ready to go, when you click inside the taskbar search
box, the following will be displayed.





Just click on the Mic icon in the bottom right corner and start
speaking.

If your mic is not configured very well and Cortana is not able to hear
you clearly, the following box will pop up automatically, will ask you to
set up your Mic. Just click on Next.



Cortana will now give you a phrase for you to repeat. So clear your
throat properly, get ready and then click Next  .



Now, it will ask you to read a sentence. Read it very clearly, make
sure that there is no other noise in the room.



Once it is successfully done, kindly click on Next, and you will find
out that your microphone has been correctly set up.



Now you can try again and ask Cortana something. Try to
ask something like How old are you  or you can say Tell me a joke
 and see if you get a proper response.





You will then see Cortana respond.





In the case you left this process half way, you can pick it up later on.
When you click next inside taskbar search, you will now see Cortana
display the following Welcome back  message.





You can then continue from where you had left.

CHAPTER NINE
FIXING SMALL DESKTOP ICONS AND TEXT TOO

SMALL

Desktop Icons very small?  Fix it



As it was mentioned earlier, this information is as well for the senior
citizens, and with them, eyesight is an issue. They might find the
default desktop icons very small to read but they don’t have to worry,
you can easily increase the size with just a few clicks.

Simply right click your mouse and then click on View and select
Large Icons. That’s just it, and you will now see the enlarged icons
on your desktop.

Text very Small? Fix it



Also you may want to increase the text size in your Windows 10 PC.
This is just very simple and it’s a matter of few clicks.

Simply right-click your mouse and then click on the Display Settings.
This will now open up a new window. Kindly click on ‘Change the
size of text, apps,  and some other items’ and increase it, and it’s
done.

CHAPTER TEN
CONNECTING TO THE INTERNET





When we make use of a computer, we need an internet connection
as well. While it is actually simple to connect with the WiFi or the
Ethernet connection, the absolute beginners might need few helps.
However, if there is a WiFi connection at home or at the office, the
devices are normally connected already, but if you still have to do it
manually, you don’t need to worry.

If you want to set up an internet connection, simply go to the most
right corner of your taskbar, there you will locate a Network icon, it
could be a WFi or an Ethernet icon that you will see. Just click on it,
and it will open up a small window for you. Now, find your network
and then click on Connect. If your WiFi is protected by a password,
which it suppose to be, then you will need a password to connect.
Your WiFi icon will light up immediately if you have established the
connection successfully. When you see a yellow exclamation mark
or you see a red cross with the WiFi icon, it means there is some
fault at the modem or Wifi connection. You have to seek some
technical help in that case.

How to Surf Internet:
Now, when your PC is properly connected to the internet, you would
certainly want to browse the internet. For that reason, you need to
install a browser on your PC. The Microsoft Edge, the default



Microsoft browser is definitely installed in every Windows 10 PC.
Kindly open the Start Menu by pressing the Windows icon and then
click on Microsoft Edge. This will now open the web browser, and
then you can start browsing the internet as you want and enjoy
amazing things online.

CHAPTER ELEVEN
SHUTTING DOWN THE PC

Now when you have mastered how to start up the PC and use it, you
should also know how to shut down your PC properly. There are
quite a few steps to shut down your PC, but here i have covered the
two main ones. Never you turn off the power button directly, you
have to shut down your PC in the correct way for a smooth
functioning.



1. Simply Right-click on the Start Button to open the WinX
Menu.



Now press on Shutdown or sign-out link and the options for Signing
out, Sleep, Shut down and Restart will appear. Just click on Shut
down to power down the computer, it’s done.

2. You can as well click on the Start button to open the Start
Menu. On the lower left corner, you will see a power button
there.





Simply click on that button, and you will now get these three options-
Shut Down, Restart, and Sleep. Kindly click on Shut down and wait
for PC to turn off properly.

THE END
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